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Experiment-01 

Name of the Experiment: To identify different components of Computer, Switch on 
and Booting Process Shut down, Restart of computer. 
Apparatus Required: 

Sl. No. Name of the Equipment 
01 Personal Computer 

Procedure: 
Identification of different component of Computer 
KEYBOARD: It is an input device. The keyboard allows the user to intract with the 
computer directly. Keyboard has Alphabet Key, Number key, some special function 
keys(F1,F2………F12) Escape key (ESC) , Caps lock keys, Tab keys, Shift keys, Control 
keys , Alt keys and Enter keys etc. 
MOUSE: It is an input device which used to point and select on the VDU/Monitor. A 
mouse has left button, right button and scroll. The function of each button is 
determined by the programme that uses the mouse. A mouse can be classified as 
optical or mechanical mouse depends upon the basic technology. 
MONITOR: The most commonly used output devices is monitor. It is used to display 
information on the screen. The information modes are text mode or graphical mode. 
CPU: (CENTRAL PROCEESING UNIT): It is the brain of computer where all data should 
manipulate with specified instruction then it display output. It also controls the input, 
output, and storage devices. The CPU is divided into 3 basic parts. 
a) Memory Unit 
b) Control Unit 
c) ALU (Arithmetic and logic unit) 
a) Memory unit: It is called the main storage unit where we can 
store the data temporarily or permanently. 
b) Control unit: - It is the central nervous system of computer, which 
control, maintain order or direct the operation of the entire 
system. It also controls the input output(I/O) devices. 
c) ALU: It performs the arithmetical calculation and logical decision. 
It also manipulated the data like addition, multiplication, 
subtraction and division. 
STEP TO SWITCH ON THE COMPUTER 
1. Switch on the power switch from the switch board. 
2. Switch on UPS. 
3. Switch on the CPU. 
4. Switch on the monitor. 
BOOTING PROCESS 
The booting is a process of switching on the computer and starting the operating 
system. 
STEPS FOR BOOTING 
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1. The Startup 
It is the first step that involves switching the power ON. It supplies electricity to the 
main components like BIOS and processor. 
 
2. BIOS: Power On Self Test 
It is an initial test performed by the BIOS. Further, this test performs an initial check 
on the input/output devices, computer’s main memory, disk drives, etc. Moreover, if 
any error occurs, the system produces a beep sound. 
 
3. Loading of OS 
In this step, the operating system is loaded into the main memory. The operating 
system starts working and executes all the initial files and instructions. 
 
4. System Configuration 
In this step, the drivers are loaded into the main memory. Drivers are programs that 
help in the functioning of the peripheral devices. 
 
5. Loading System Utilities 
System utilities are basic functioning programs, for example, volume control, 
antivirus, etc. In this step, system utilities are loaded into the memory. 
 
6. User Authentication 
If any password has been set up in the computer system, the system checks for user 
authentication. Once the user enters the login Id and password correctly the system 
finally starts. 
 
STEP TO SHUT DOWN THE COMPUTER 
1. Press alt+f4 key simultaneously, select shut down option and click 
on ok. 
Or 
Press the windows key from the keyboard or move the mouse pointer to the extreme 
right corner of the screen i.e. just above the taskbar, click on setting, click on power, 
click on shut down. 
STEP TO RESTART THE COMPUTER 
Press the Reset button to restart the computer, or press CTRL + ALT + DEL or click on 
start button , then click on restart option to restart the computer. 
LAYOUT OF FRONT PANEL & BACK PANEL OF COMPUTER 
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Experiment-2 (Personal Computer System) 

Aim of the experiment: 

Study of device, power supply form factor, identification of Motherboard 
component, different port, connector, cooling system, processor, case 

Apparatus Required: 

Sl. No. Name of the Equipment 
01 Personal Computer 

Procedure: 

Motherboard: 

A motherboard is the main printed circuit board (PCB) in a computer. The 
motherboard is a computer's central communications backbone connectivity point, 
through which all components and external peripherals connect. 

Components of Motherboard: 

 
 

1. PCI Slot – This board has 2 PCI slots. These can be used for components 
such as Ethernet cards, sound cards, graphics card and modems. 
2. Northbridge – It allows communication between the CPU and the system 
memory and PCI-E slots. 
3. ATX power connection – This is one of the connections that supply 
power to the motherboard. This connection will come from your Power 
Supply. 
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4. CPU – Fan Connection – This is where your CPU fan will connect. Using 
this connection over one from your power supply will allow the 
motherboard to control the speed of your fan, based on the CPU 
temperature. 
5. Socket – This is where your CPU will plug in. The bracket that is 
surrounding it is used for high end heat sinks. It helps to support the 
weight of the heat sink. 
6. Memory slots – These are the slots for your RAM. Most boards will have 
4 slots, but some will only have 2. 
7. IDE connection – The IDE(Integrated Drive Electronics) is the connection 
for your hard drive or CD / DVD drive. Most drives today come with 
SATA connections, so we may not use this. 
8. Southbridge – This is the controller for components such as the PCI 
slots, onboard audio, and USB connection. 
9. SATA connections – These will be used for hard drives, and CD / DVD 
drives. 
10.Front Panel connections – This is where you will hook in the connections 
from your case. These are mostly the different lights on your case, such 
as power on , hard drive activity etc. 
11. FDD connection – The FDD is the floppy Disk controller. If you have a 
floppy disk drive in your computer, this is where you will hook it up. 
12. External USB connections – This is where you will plug in external USB 
connections for your case or USB bracket. 
13. CMOS battery – This is the motherboard’s battery. This is used to allow 
the CMOS to keep it settings 

Types of ports and connectors 
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Experiment-3 

(Computer Lab safety and study of Lab Tools) 

Aim of the Experiment: 

To study of various types of LAB Safety measures and procedures for proper 
disposal or recycling of hazardous computer components 

Apparatus Required: 

Sl. No. Name of the Equipment 
01 Personal Computer 

Lab Safety Measures: 

Safety guidelines help protect individuals from accidents and injury. They also help to 
protect equipment from damage. Some of these guidelines are designed to protect 
the environment. 
1) General Safety 
Safe working conditions help prevent injury to people and damage to computer 
equipment. A safe workspace is clean, organized, and properly lighted. Everyone 
must understand and follow safety procedures. 
CAUTION 
This is a partial list of basic safety precautions to use when working on a computer: 
·�Remove your watch and jewellery and secure loose clothing. 
·�Turn off the power and unplug equipment before performing service. 
·�Cover sharp edges inside the computer case with tape. 
·�Never open a power supply or a CRT monitor. 
·�Do not touch areas in printers that are hot or that use high voltage. 
·�Know where the fire extinguisher is located and how to use it. 
·�Keep food and drinks out of your workspace. 
·�Keep your workspace clean and free of clutter. 
·�Bend your knees when lifting heavy objects to avoid injuring your back. 
2) Electrical Safety 
Follow electrical safety guidelines to prevent electrical fires, injuries, and fatalities in 
the home and the workplace. 
CAUTION 
·�Do not wear the antistatic wrist strap when repairing power supplies or CRT 
monitors. Only experienced technicians should attempt to repair power 
supplies and CRT monitors. 
·�Some printer parts become hot during use, and other parts might contain high 
voltage. Check the printer manual for the location of high-voltage 
components. Some components retain a high voltage even after the printer is turned 
off. Make sure that the printer has had time to cool before making the repair. 
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·�Electrical devices have certain power requirements. For example, AC 
adapters are manufactured for specific laptops. Exchanging power cords with 
a different type of laptop or device may cause damage to both the AC adapter 
and the laptop. 
3) Fire Safety 
Fire can spread rapidly and be very costly. Proper use of a fire extinguisher can 
prevent a small fire from getting out of control. 
CAUTION 
follow these safety procedures: 
·Never fight a fire that is out of control or not contained. 
·Always have a planned fire escape route before beginning any work. 
·Get out of the building quickly. 
·Contact emergency services for help. 
·Locate and read the instructions on the fire extinguishers in your workplace. 
before you have to use them. 
Analysis of various Power Fluctuation Types (Blackout, Brownout, Noise, Spike) 
The following types of AC power fluctuations can cause data loss or hardware failure: 
·Blackout - Complete loss of AC power. A blown fuse, damaged transformer, 
or downed power line can cause a blackout. 
·Brownout - Reduced voltage level of AC power that lasts for a period of time. 
Brownouts occur when the power line voltage drops below 80 percent of the 
normal voltage level. Overloading electrical circuits can cause a brownout. 
·Noise - Interference from generators and lightning. Noise results in poor 
quality power, which can cause errors in a computer system. 
·Spike - Sudden increase in voltage that lasts for a short period and exceeds 
100 percent of the normal voltage on a line. Spikes can be caused by lightning strikes 
but can also occur when the electrical system comes back on after a blackout. 
·Power surge - Dramatic increase in voltage above the normal flow of 
electrical current. A power surge lasts for a few nanoseconds, or one-billionth 
of a second. 
Power Protection Devices 
To help shield against power fluctuation problems, use devices to protect the data 
and computer equipment: 
·Surge suppressor - Helps protect against damage from surges and spikes. A 
surge suppressor diverts extra electrical voltage that is on the line to the 
ground. 
·Uninterruptible power supply (UPS) - Helps protect against potential 
electrical power problems by supplying a consistent level of electrical power to 
a computer or other device. 
·Standby power supply (SPS) - Helps protect against potential electrical 
power problems by providing a backup battery to supply power when the incoming 
voltage drops below the normal level. The battery is on standby during normal 
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operation. When the voltage decreases, the battery provides DC power to a power 
inverter, which converts it to AC power for the computer. This device is not as 
reliable as a UPS because of the time it takes to switch over to the battery. If the 
switching device fails, the battery cannot supply power to the computer. 
Procedures for proper Disposal or recycling of computer components 
Equipment Disposal 
Batteries 
Monitors 
Toner Kits & Cartridges 
Chemical Solvents and Aerosol Cans 
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Experiment-4 

Working with MS DOS (Microsoft DOS Operating System) 

Aim of the Experiment: To perform internal and external DOS Commands. 

Apparatus Required: 

Sl. No. Name of the Equipment 
01 Personal Computer with DOS operating System 

Procedure: 

INTERNAL COMMANDS: SET, PATH, DIR, MD, CD, CD..,BREAK  

EXTERNAL COMMANDS: ATTRIB,TREE,CHKDSK,APPEND 

1. DIR 

 C:\>DIR 

 
2. CD 
C:\>USERS>CD.. 
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3. TYPE 
D:\>TYPE TRY.TXT 

 
4. DEL 
D:\>DEL TRY.TXT 
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5. MD 
D:\>MD STUDENT 

 
Copy 
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6. RMDIR 
D:\>RMDIR STUDENT 
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8) VER, DATE, TIME 
D:\>VER 
D:\>DATE 
D:\>TIME 

 
9) COPY CON 
D:\>COPY CON 
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10) SET, PATH 
D:\>PATH 
D:\>SET 

 
TREE 
C:\>TREE 
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APPEND 
C:\>APPEND 

 
ATTRIB 
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C:\>DOCUME~1>USER4>ATTRIB 
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Experiment-5 

Working with Basic Windows Operating System 

Aim of the Experiment: To perform different operations using Windows Operating 
System. 

Apparatus Required: 

Sl. No. Name of the Equipment 
01 Personal Computer with Windows operating System 

Windows operating is a  type of system software that acts as an interface between 
the users of a computer and the computer hardware. It acts as the resource manager 
that use the computer resources like CPU, memory,files and I/O devices in an efficient 
manner. Example: MS DOS, MS Windows, Unix etc. There are various versions of MS 
Windows available like Windows XP, Vista, 7,8 or 10. 

Basic components of windows: 

Window: A window is an area of desktop within which all widows-based program 
run. 

Desktop: Desktop refers to main background area. We can customize desktop in 
various ways such. 
as editing background pictures, changing background colour and changing the icons 
on the desktop. 
There are small pictures which appear on the left side of the desktop called icon. We 
choose are of 
the icon by double clicking on it. 
Taskbar: The taskbar is a simple row at the very bottom of the screen where all 
currently opened 
files or applications are listed. It helps you select what you want to keep opened and 
what you want. 
to close. 
Start Menu: By clicking the start menu, in the bottom left corner of the screen, a 
vertical window. 
consisting of the recently opened applications and saved locations will pop-up. 
Clock: It displays the current time. It appears on the right side of the taskbar. 
My computer: It provides a quick access to our computer disk device. Control panel 
and internal 
devices. 
My document: It provides a complete space to store our document. 
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Recycle bin: It stores all the information of all the deleted files and folder. It also 
allows us to recover. 
them. 
Network place: It allows us to view or display various network available and files and 
folders on our network. 
Maximize/Minimize/Close Buttons: 
These buttons are located at the top right corner of our opened documents, and the 
area used to close, minimize or maximize the document window. They help us jump 
from one task to another fast and let us decide either we want to close an application 
or resize it’s area on the screen or just hide it for a few moments 
WINDOWS UTILITIES & ACCESSORIES 
In Windows 10 we still have well-known Windows Accessories folder. It is available in 
Start Menu > All Apps > Windows Accessories. 
1. Note pad: It is a simple text editor for Microsoft windows. It is a common text only 
editor which have no format tags or styles. The extension name is .TXT . 
2.Word pad: It is a basic word processor. It is more advanced then note pad but less 
efficient then 
Microsoft word. The extension name is .DOC. 
3. Paint: It is a drawing tool. The extension name is .BMP 
4. Calculator: It is commonly used icon calculating tools in window OS. 
5. Character Map: It is the built-in utility for helping us insert all possible text symbols 
or special characters into our document. 
6. Sound recorder: It record sound and save it in the computer MOUSE OPERATIONS 
A computer mouse is a hand-held pointing device that detects two-dimensional 
motion relative to a surface. This motion is typically translated into the motion of a 
pointer on a display, which allows a smooth control of the Graphical User Interface of 
a computer. On a standard mouse, there are three controls: Left button, Right button 
and the wheel in between. 
Operations: 
A mouse typically controls the motion of a pointer in two dimensions in a graphical 
user interface 
(GUI). 
Different ways of operating the mouse cause specific operations to be performed in 
the GUI: 
• Click: pressing and releasing a button. 
• (left) Single-click: Clicking the left mouse button once. 
• (left) Double-click: Clicking the left button two times in quick succession. Point to 
the icon to open (My Computer) on the desktop and then double-click by quickly 
pressing and releasing the left mouse button twice without moving the mouse. 
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• Right-click: Clicking the Right button. Point to any icon on the desktop or in a 
window or a 
selected character, word or paragraph and then click the right mouse button. This 
brings a shortcut menu with different options depending on the software. Some of 
the options are enabled (black colour) and some disabled (gray colour). The disabled 
options become enabled(black) only if the object is selected. 
DRAG AND DROP: In computer graphical user interface drag and drop is the action of 
clicking on an object and dragging it to a different location as required. 
The basic sequence involved in drag and drop is: 
• Press and hold down, the button on the mouse or the other pointing device to 
“grab” the object. 
• “Drag” the object/ cursor/ pointing device to the desired location. 
“Drop” the object by releasing the button. 
FIND FILES AND FOLDERS: 
Click on start button. The start menu will appear. 
Highlight search. 
Click files or folders. The search results dialog box will open. 
Choose on option. 
Enter your search criteria. Use the table that follows to help you. 
Click search. The results of your search will appear in the right pan. 
CHANGE WINDOW TASKBAR PROPERTIES: 
Right-click a blank area of the taskbar. 
From the menu, select properties. 
In the taskbar and start menu properties dialog. 
Check group similar taskbar buttons. 
Click ok. 
CREATE A SHORTCUT TO AN ITEM ON THE DESKTOP 
Click start. The start menu will appear. 
Locate the item which you want to create a shortcut. If the item is located on a 
submenu, go to the submenu. 
Click and drag the item on your desktop. 
KEYBOARD OPERATIONS: 
This table lists the commonly used shortcut keys: 
TO PRESS 
Activate Help F1 
Activate context- sensitive Help Shift –F1Zoom in (limit 1600%) PgUP 
Zoom out (limit 25%) PgDN 
Switch windows forward F6 
Switch window backward Shift-F6 
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Undo an operation CTRL-Z 
Redo an operation CTRL-Y 
Close Maxlm DL ALT-F4 
Open a file CTRL-N 
Save a file CTRL-S 
Create a new file CTRL-N 
Open camera control window CTRL-W 
Open Observatory control window CTRL-T 
FILE EXPLORER / WINDOWS EXPLORER AND UTILITIES 
File / Windows Explorer: It is a place we can view the drives on your computer and 
manipulate the folders and files using windows explorer. We can cut, copy, Paste, 
Rename and delete folders and files. 
To Open Windows Explorer: 
I. Click the start button, located in the lower left corner on our screen. 
II. Go to the programs. 
III. Go to Accessories. 
IV. Click windows explorer. 
To create file/folders: Open windows explorer ® Right click in right side ® New ® 
File/Folder To cut/copy/paste/delete- File/Folder 
CUT: 
• Select what you want to cut. 
• Click Edit, which is located on the menu bar. A drop-down menu will appear. 
• Click Cut. 
PASTE: 
• Place the cursor at the point where you want to place the information that is 
currently on the Clipboard. 
• Click Edit. A drop-down menu will appear. 
• Click Paste. 
COPY: 
• Select what you want to copy. 
• Click Edit, which is located on the menu bar. A drop-down menu will appear. 
• Click copy. 
Using keyboard shortcuts : 
Cut: 
• Select what you want to cut. 
• Press Ctrl + X. 
Paste: 
• Place the cursor at the point where you want to place the information that is 
currently on 
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the Clipboard. 
• Press Ctrl + V. 
Copy: 
• Select what you want to copy. 
• Press Ctrl + C. 
Expanding and collapsing explorer folders : We will find a (+) and (-) sign on the left 
side of the list 
of folders. 
By clicking on “+” sign we expanding the folder or click on “-“ sign we collapse the 
folders. 
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Experiment-6 

Basic operations of Word Processing Package. (MS-Word) 

Aim of the Experiment: To study and perform various operations using MS Office. 

Apparatus Required: 

Sl. No. Name of the Equipment 
01 Personal Computer with MS Office Suit 

MS-WORD is the part of the bigger package called MS-OFFICE. We can do much more 
than word processing. 

What is word processing? 
Word processing is a software package that enables you to create, print and save 
document for future retrial and reference creating a document involves typing by 
using a keyboard and saving it editing a document a document involves correcting 
the spelling mistakes if any deleting or moving words sentence or paragraph. 
Advantages of word processing: 
Word processor over a conventional typewriter is that a word processor enables you 
to may change to a document without retyping the entire document. 
Features of word processing: 
1. Text is typing into the computer which allows alteration to be made easily 
2. Word and sentence can be inserted or deleted. 
3. Paragraph or text can be copy/move throughout the documents. 
4. Margins and page length can be adjusted as desired. 
5. Spelling can be checked and modify through the spell check facility. 
6. Multiple documents/files can be merged. 
7. Multiple copies of letters can be generated with different address through the 
male merger facility. 
Some commands of a word processing package: 
1. Create New Document. 
2. Save Document 
3. Insert Word Art. 
4. Insert Chart 
5. Footer. 
6. Header. 

Important components of the screen: 
1. Title bar: - The title bar displayed the name of the currently active word document 
like other 
windows applications. 
2. Toolbar: - Word has a number of tool bar that help you perform task faster and 
with great 
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easy two of the most commonly toolbar are the formatting toolbar and the standard 
toolbar. 
3. Ruler bar: - the ruler bar allows you to format the vertical alignment of text in a 
document. 
4. Status bar: - The status bar displays information about the currently activate 
document. This 
includes the page no. that you are working. 
5. Scroll bar: - This bar helps scroll the content or body of document. 
6. Work space: - The work space is the document windows where you enter/type the 
text of 
your document. 
7. Main menu: - The word main menu is displayed at the top if the screen. 

 
Create a new Document: 

Step 1 - Click the File tab and select the New option. 

· The New Document dialog box appears. 

· Select Blank document under the Blank and recent section. It will be 
highlighted by default. 
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·  
Add and format text 

1. Place the cursor and type some text. 
2. To format, select the text and then select an option: Bold, Italic, Bullets, Numbering, 

and more. 

 
Add Pictures, Shapes, SmartArt, Chart, and more 

1. Select the Insert tab. 
2. Select what you want to add: 
3. Tables - select Table, hover over the size you want, and select it. 
4. Pictures - select Pictures, browse for pictures from your computer. 
5. Shapes - select Shapes, and choose a shape from the drop-down. 
6. Icons - select Icons, pick the one you want, and select Insert. 
7. 3D Models - select 3D Models, choose from a file or online source, go to the image 

you want, and select Insert. 
8. SmartArt - select SmartArt, choose a SmartArt Graphic, and select OK. 
9. Chart - select Chart, select the chart you want, and select OK. 
10. Screenshot - select Screenshot and select one from the drop-down. 
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To insert a header or footer: 

· Select the Insert tab. 

· Click either the Header or Footer command. A menu appears with a list 
of built-in options you can use. 

· Left click one of the built-in options, and it will appear in the document. 
 
OR 

· Left click Blank to select it. 
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· Saving New Document 
· Once you are done with typing in your new Word document, it is time to save your 

document to avoid losing work you have done on a Word document. Following are 
the steps to save an edited Word document - 

· Step 1 - Click the File tab and select the Save As option. 
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Experiment-7 

Basic operations of Microsoft Excel. (MS-Excel) 

Aim of the Experiment: To study and perform various operations using MS Excel 

Apparatus Required 

Sl. No. Name of the Equipment 
01 Personal Computer with MS Office Suit 
 

MS Excel 
Introduction to Microsoft Excel 2007 
Microsoft Excel is a very powerful tool for you to use for numeric computations and 
analysis Excel can also function as a simple database but that is another class. Today 
we will look at how to get starting with Excel and show you around the neighborhood 
sort of speak. 
Starting MS-Excel 2007 
·�To start Microsoft Excel: 
·�Click once on the Start button on the bottom left corner of the screen. 
·�Click on All Programs. 
·�Move the cursor to the new menu on the right and then click on Microsoft Office 
2007. 
·�Move the cursor to the next menu that opens and click Microsoft Office excel 
2007. 
·�A blank document will appear on the screen. 
Main screen of a Microsoft Excel 2007 Document 
This is a workbook. A workbook is a collection of worksheets (spreadsheets) and 
macros. By default, Excel creates 3 worksheets in a new workbook. The worksheets 
are designated at the bottom part of the window where you see the file folder-like 
tabs. The tabs are named Sheet1,Sheet2 and Sheet3. If you click on Sheet2, you will 
be in Sheet2 and not Sheet1 so you need to be aware of which worksheet you are in. 
Office Fluent user interface 
In Excel 2007, the new Office Fluent user interface replaces the traditional menus and 
toolbars from previous versions of Excel with a single mechanism designed to help 
users find the right features more efficiently. 
The interface contains three main components: 
·Office Button 
·Quick Access Toolbar 
·Ribbon 
Open a New Workbook 
Sometimes you have to create a new workbook. 
1. Click on the Office Button 
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2. Click on New 
You are now able to open recently used or new workbooks from this panel. You can 
also open up templates that are available with Excel or ones that you create. If you 
click on Blank Workbook, Excel will create a new workbook for you. 
What are Columns, Rows, and Cells? 
·Columns are the vertical markers in the worksheet and are denoted by the alphabet 
i.e. A, B, C. 
·The rows are the horizontal markers in the worksheet and are denoted by numbers 
i.e. 1, 2, 3. 
·Cells are the single box that you get where the column and row intersect i.e. A1, B3, 
and C2. 
You will often need to know the cell reference. The cell reference is the cell‘s name 
and you can find that by looking at the toolbar. This means that the cell that is 
selected is named C28. 
Selecting a cell 
1. We are going to select C28. Look for the C column. 
2. Look for the Row number 28. 
3. You may use your finger to follow the column C down to where row 28 is. 
4. Once you have located it, click on it. 
5. Look at the toolbar; the cell reference box should say C28. If it does not, try again. 
6. After you have done this, click on a different cell and note the cell reference box. 
Selecting a group of cells A4 to D10 
1. Click on the first cell A4 
2. Click and Hold the mouse button down. Drag the cursor down to D10. 
3. Let go of the mouse button. 
4. If you did it correctly, you should see a Highlighted box around those cells. If not, 
try again. Please see the picture on the next page. 
Basic data entry, fill handle. 
From the example, we have numeric (year, numbers) and text (months) entered as 
data in our worksheet. Let us practice by re-creating the example on our own. 
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Method 1 
1. Click on cell A2 to select it. 
2. Type in 1981 and hit Enter. Notice by hitting Enter, we automatically move down 
to the 
next row. (we can also do the same by hitting the down arrow) 
3. Click on cell B1 to select it. 
4. Type in January and hit Tab. By hitting Tab (or right arrow), we move to the next 
column. We can continue to doing this to enter the data from 1981 to 1992 and so 
on, but Excel provides us with a tool to complete sequences. 
Method 2: 
1. Click on cell A2 to select it. 
2. Type in 1981 and hit Enter. 
3. Type in 1982, and then select both cells A2 and A3. 
4. Move your mouse cursor over the fill handle (small black box on the bottom right 
of the, active cell) so that the cursor turns into a cross. 
5. Click and drag the fill handle down to the cell desired. 
Copy, Cut, Paste 
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You can Copy, Cut and Paste anything into your worksheet. You can copy from one 
worksheet to another worksheet in another book. Let‘s concentrate on the basics. 
We are going to copy cells D4 to H9. 
Cut/Copy and Paste to the same worksheet. 
1. Using the same worksheet, select cells A4 to D10. 
2. Use CTRL-c to copy and CTRL-x to cut the selected cells. 
3. Click on cell E29. It should be blank. 
4. Use CTRL-v to paste the data. 
You can also use the toolbar shortcuts for cut/copy/paste as the functionality is the 
same. 
Insert & delete columns, rows, and cells 
Have you ever entered all of your data and realized that you are missing an entry in 
the middle of the worksheet? If yes and you did not know how to add columns or 
rows, it would be really difficult to fix. Well, there is an easier method. 
You can insert columns, rows, or cells in any spot on your worksheet. 
Using the sort feature 
We want to insert a new row for Anne Frank‘s contact information between John Doe 
1. And Fred Johnson but this time we will create her record in line 5. 
1. Select cells A1 to G5 
2. Go to the Data tab, then click on Sort 
3. In the sort option window, use the pull down boxes to select the sort criteria. In 
this case 
we want to sort by Last Name, ascending order A-Z, then click on OK. 
Delete columns and rows 
We all make mistakes. It is very easy to remove a column or rows. 
1. Select the column or row that you want to delete. 
2. Point at the highlighted column name or row name and right click. 
3. A pop-up menu should appear 
4. Select Delete 
5. The column or row should be gone. 
Inserting & deleting new worksheets 
There will be many times when you need to add a whole worksheet rather than 
columns or rows. 
Insert a worksheet: 
1. Right Click on the tabs where the name of the worksheets are. 
2. Click on Insert 
3. Select what kind of insert you want from the window. 
4. To move the worksheet, click and hold the left mouse button on the worksheet 
tab. Drag 
the tab to where you want it to be placed. Note: you can only move the worksheet 
tabs to 
the left or right. 
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Delete a worksheet: 
1. Click on the tab of the worksheet that you want to delete. 
2. Right Click on the same tab of the worksheet 
3. Click on Delete 
Printing 
Printing your worksheets out to a printer would be a nice thing to know how to do. If 
the information that you have on the worksheet fits on an 8.5‖x11‖ paper, you have 
no trouble printing your worksheet out. The problem arises when you have a larger 
worksheet. You may have noticed that your worksheet has dashed lines running 
down and across it; this is your print area. 
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Experiment-8 

Basic operations of Microsoft PowerPoint. (MS-PowerPoint) 

Aim of the Experiment: To study and perform various operations using MS 
PowerPoint 

Apparatus Required 

Sl. No. Name of the Equipment 
01 Personal Computer with MS Office Suit 

MS-POWER POINT 
The presentation software is used for creation of the slides and to display the 
information in form of presentation software are easy to use and provide an 
alternative to other older types of visual aids like hand drawn slides, black board, 
posters, hand outs or overhead transparency. A presentation software provide tool 
like editor that allows insertion and formatting of text and methods for inserting and 
manipulating graphics images along with sound and visual effects. 
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Features of MS-Power point: 
1. Design. 
2. Flexibility. 
3. Animation. 
4. Presentation. 
5. Effects. 
6. Multimedia. 
7. Integration. 
Presentation terminology: 
1. Audience hangouts. 
2. Free hand drawing. 
3. Object. 
4. Outline. 
5. Placeholder. 
6. Slides. 
7. Speaker‘s notes. 
Starting the MS-Power point: 
1. Using the start menu. 
(a) Click on start button. 
(b) Click at programs. 
(c) Click on MS-Office sub menu. 
2. By using shortcuts. 
User can use these facilities if the icon of the software has been created and it put on 
desktop. 
3. By using Microsoft office bar. 
4. Menu bar and menu. 
5. Screen of MS-Power point. 
Screen of MS Power Point: 
1. Title bar: The title bar displayed the name of the currently active word document 
like other windows applications. 
2. Toolbar: Word has a number of tool bar that help you perform task faster and with 
great easy two of the most commonly toolbar are the formatting toolbar and the 
standard toolbar. 
3. Ruler bar: The ruler bar allows you to format the vertical alignment of text in a 
document. 
4. Status bar: The status bar displays information about the currently activate 
document. This includes the page no. that you are working. 
5. Scroll bar: This bar helps scroll the content or body of document. 
6. Workspace: The workspace is the document windows where you enter/type the 
text of your document. 
7. Main bar: The word main menu is displayed at the top if the screen 
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EXPERIMENT à9 
Working with Internet 

Aim of the Experiment: To study about web browser and working with Internet and 
Email. 
Apparatus Required: 

Sl. No. Name of the Equipment 
01 Personal Computer with Internet Connectivity 

Procedure: 
Web browser & E-Mail 
A web browser is a software application which enables a user to display and interact 
with text, images, videos, music, and other information that could be on a website. 
Text and images on awe page can contain hyperlinks to other web pages at the same 
or different website. Web browsers allow a user to quickly and easily access 
information provided on many web pages atman websites by traversing these links. 
Web browsers format HTML information for displays the appearance of a web page 
many differ between browsers. 
Purpose: 
Web browser defines the application software that is designed for the Web browser 
is used to run the software application that allows retrieving, presenting and 
traversing the information from one place to another Web browser provides the 
resources using the WWW (World Wide Web) this can be identified by URI (Uniform 
Resource Identifier).Web browser fetches the data like web page, image, video or 
other piece of content from the server and displays it accordingly Web browser uses 
hyperlinks to display the resources and allow the users to navigate their browsers 
user to access and retrieve the documents using the Internet. 
Protocols and Standards 
Web browsers communicated with web servers primarily using HTTP (hypertext 
transfer protocol) to fetch web pages. HTTP allows web browsers to submit 
information to web servers as well as fetch web pages from them. Pages are 
identified by means of a URL (uniform resource locater), which is treated as an 
address, beginning with ―h�p://‖ for HTTP access. The file format for a web page is 
usually HTML (hyper-text markup language) and is identified in the HTTP protocol. 
Most web browsers also support a variety of additional formats, such aspen, PNG, 
and GIF image formats, and can be extended to support more through the use of 
plug-in. The combination of HTTP content type and URL protocol specification allows 
webpage designers to embed images, animations, video, sound, and streaming media 
into a webpage, or to make them accessible through the web page. 
Popular Browsers 1. Firefox 
Firefox is a very popular web browser. One of the great things about Firefox is that it 
is supported on all different OSs. Firefox is also open source which makes its support 
group Avery large community of open source developers. Firefox is also known for its 
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vast range of plugins/add-ons that let the user customize in a variety of ways. Firefox 
is a product of the 
Mozilla Foundation. The latest version of Firefox is Firefox 3.Some of Firefox‘s most 
prominent features includes: tabbed browsing, a spell checker, incremental find, live 
bookmarking, a download manager, and an integrated search system that uses the 
user‘s favorite search engine. Like mentioned before, one of the best things about 
Firefox is its vast amount of plugging/addons. Some of the most popular include No 
Script (script blocker), Foxy Tunes (controls music players), Ad block Plus (ad blocker), 
Stumble Upon (website discovery), Down Them All! (Download functions), and Web 
Developer (web tools). 
2. Internet Explorer 
Internet Explorer (IE - created by Microsoft) is a very prominent web browser for the 
Windows. IE is the most popular web browser. It comes pre-installed on all Windows 
computers. The latest version of IE is IE7 with IE8 in beta. IE was designed to view a 
broad range of web pages and to provide certain features within the OS.IE almost 
fully supports HTML 4.01, CSS Level 1, XML 1.0, and DOM Level 1. It has introduced a 
number of proprietary extensions to many of the standards. This has resulted in 
number of web pages that can only be viewed properly using IE. It has been subject 
to many security vulnerabilities just like Windows has. Much of the spyware, adware, 
and viruses across the Internet are made possible by exploitable bugs and flaws in 
the security architecture of IE.These are drive-by downloads come into play (see 
computer security lesson for more details on that). 
E-mail: 
E-mail (electronic mail) is the exchange of computer-stored messages by 
telecommunication. (Some publications spell it email; we prefer the currently more 
established spelling of e-mail.) E-mail messages are usually encoded in ASCII text. 
However, you can also send non-text files, such as graphic images and sound files, as 
attachments sent in binary streams. E-mail was one of the first uses of the Internet 
and is still the most popular use. A large percentage of the total traffic over the 
Internet is e-mail. E-mail can also be exchanged between online service provider 
users and in networks other than the Internet, both public and privateer-mail can be 
distributed to lists of people as well as to individuals. A shared distribution list can be 
managed by using an e-mail reflector. Some mailing lists allow you to 
subscribe by sending a request to the mailing list administrator. A mailing list that is 
administered automatically is called a list server‘s-mail is one of the protocols 
included with the Transport Control Protocol/Internet Protocol (TCP/IP) suite of 
protocols. A popular protocol for sending e-mail is Simple Mail Transfer Protocol and 
a popular protocol for receiving it is POP3. Both Netscape and Microsoft include an e-
mail utility with their Web browsers. 
How to Create a Email 
Gmail has been increasing in popularity since it was first introduced in 2004. With the 
decline of Yahoo!, AOL, and Hotmail, more and more people are moving to Google‘s 
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services. Creating a Gmail account is quick and easy, and also provides you access to 
other Google products such as YouTube, Google Drive, and Google Plus. 
Creating Your Account 
Suppose if u want to open your account on gmail.com. Then follow the steps given 
below Open a Web browser (internet explorer or Google chrome or Mozilla etc.)write 
in address bar www.gmail.com and you will get below image Now click on "CREATE 
AN ACCOUNT", as shown in below (check the red arrow) .After clicking on "CREATE 
AN ACCOUNT‖ button you will get a window as shown in below image Fill all the 
details, here the user name is the desired user ID which you want to create. after 
felling all the details click on "Next step" Button (check the red arrow)after next step 
it will ask for Phone number for verification, enter cell phone number and click on 
next now click on "next step " button and you will get you inbox Cong‘syou have 
created your new Gmail ID Enjoy your new Gmail account. You're finished! Click on 
"Continue to Gmail" to access your inbox, read your emails, and write new ones. 
Use of Email 
Email is one of the most important forms of communication in today's digital age. It's 
the way that millions (if not billions) of people stay in touch with each other. Luckily, 
this form of nearinstant communication is completely free. Make a free email 
account today to starts sending and receiving email immediately. Read on below the 
jump for detailed instruction son registering a new email account with several of the 
internet's most popular email providers. Go to Gmail.com. The first step to creating 
an email account with Gmail, Google's free email service, is to visit Gmail's main site. 
Type "gmail.com" into your browser's navigation bar, or, alternatively, type "Gmail" 
into your search engine of choice and click the relevant result. The email is actually 
used to transfer messages between one to another. It is also used for:- 
1. Group discussion by making groups in hotmail, yahoo, etc 
2. Stay in touch with users attached in the group. 
3. Transmitting documents through attachments 
4. Group email to multiple users 
5. Convenient way of sending job application. 
6. Easy method of advertisement. 
7. Receiving conformation of service. 
8. Service subscription 
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EXPERIMENT à10 
“C” Programming  

Aim of the Experiment: 
To learn C programming language, its compilation and execution to get the desired 
result. 
Apparatus Required: 

Sl. No. Name of the Equipment 
01 Personal Computer with “C” Editor software 

 
Q1.W.A.P to print the message as “Welcome to Govt. Polytechnic, Balasore”. 
#include<stdio.h> 
#include<conio.h> 
void main() 
        { 
           printf(“Govt. Polytechnic, Balasore “); 
        } 
Output = 
Govt. Polytechnic, Balasore 
Q2. W.A.P to accept sum of 2numbers. 
#include<stdio.h> 
#include<conio.h> 
void main() 
       { 
           int a, b, sum; 
           clrscr(); 
           printf(“enter two nos“); 
           scanf(“%d%d”,&a,&b); 
           sum=a+b; 
           printf(“The sum of the two number is %d”,sum); 
      } 
Output = 
Enter two numbers 23 24 
Sum of numbers is 47 
Q3. W.A.P in C to find the greatest number among three numbers 
#include<stdio.h> 
#include<conio.h> 
void main() 
       { 
            int a, b, c; 
            clrscr(); 
            printf(“enter3nos“); 
            scanf(“%d%d%d”,&a,&b,&c); 
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          if(a>=b&&a>=c) 
    { 
          printf(“largestis%d”,a); 
    } 
else 
         if(b>=a&&b>=c) 
   { 
         printf(“largestis%d”,b); 
   } 
else 
       if(c>=a&&c>=b) 
  { 
       printf(“largestis%d”,c); 
  } 
}  
Output = 
Enter3nos 349070 
Largestis90 
Q4. W.A.P in C to find the average of n numbers by using for loop. 
#include<stdio.h> 
#include<conio.h> 
void main() 
{ 
int i, n, num; 
float sum, avg; 
clrscr(); 
printf(“enter the nth value : ”); 
scanf (“%d”, &n); 
for (i=1; i<=n; i++) 
{ 
printf(“enter a number : ”); 
scanf(“%d”, &num); 
sum = sum + num; 
} 
avg = sum/n; 
printf(“average of %d different number is %d : ”, n, avg); 
}  
Output = 
enter the nth value : 3 
enter a number : 25 36 78 
average of 3 different number is 46.33 
Q5. W.A.P in C to determine whether a number is prime or not ? 
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#include <stdio.h> 
void main() 
{ 
int n, i, flag = 0; 
printf("Enter a positive integer: "); 
scanf("%d", &n); 
for (i = 2; i < n / 2; ++i) 
{ 
if (n % i == 0) 
{ 
flag = 1; 
break; 
} 
} 
if (n == 1) 
{ 
printf("1 is neither prime nor composite."); 
} 
else if (flag == 0) 
{ 
printf("%d is a prime number.", n); 
} 
else 
{ 
printf("%d is not a prime number.", n); 
} } 
Output= 
Enter a positive integer: 7 
7 is a prime number. 
Q6. W.A.P in C to check whether a given number is palindrome or 
not ? 
#include <stdio.h> 
void main() 
{ 
int n, rev = 0, rem, temp; 
printf("Enter a number“); 
scanf("%d", &n); 
temp = n; 
while (temp != 0) 
{ 
rem = temp % 10; 
rev = rev * 10 + rem; 
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temp = temp/10; 
} 
if (rev == n) 
printf("%d is a palindrome number.\n", n); 
else 
printf("%d isn't a palindrome number.\n", n); 
} 
Output = 
Enter a number 131 
131 is a palindrome 
Q7. W.A.P in C to accept row wise and column wise element in a 
two dimensional array and print them. 
#include<stdio.h> 
#include<conio.h> 
void main() 
{ 
int i, j, mark[3][3]; 
clrscr(); 
printf("enter 9 elements "); 
for(i=0;i<3;i++) 
{ 
for (j=0; j<3; j++) 
{ 
scanf("%d",&mark[i][j]); 
} 
} 
printf("\n the matrix elements are \n"); 
for(i=0;i<3;i++) 
{ 
for (j=0; j<3; j++) 
{ 
printf("%d \t",mark[i][j]); 
} 
printf("\n"); 
} 
} 
OUTPUT = 
Enter 9 elements 
11 22 33 
44 55 66 
77 88 99 
the matrix elements are 
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11 22 33 
44 55 66 
77 88 99 
Q8. W.A.P in C to find the vowels in a given string. 
#include <stdio.h> 
int main() 
{ 
int i, count = 0; 
char s[50]; 
printf("Input a string\n"); 
gets(s); 
for (i=0; s[i]!=`\0’; i++) 
{ 
if (s[i] == 'a' || s[i] == 'A' || s[i] == 'e' || s[i] == 'E' || s[i] == 'i' || s[i] 
== 'I' || s[i] =='o' || s[i]=='O' || s[i] == 'u' || s[i] == 'U') 
{ 
count++; 
} } 
printf("Number of vowels in the string: %d", count); 
return 0; 
} 
OUTPUT = 
Input a string Rourkela 
Number of vowels in the string : 4 
Q9. W.A.P in C to find the factorial of a number by using recursion. 
int fact(int n); 
#include<stdio.h> 
#include<conio.h> 
void main() 
{ 
int num,f; 
clrscr(); 
printf("\n Enter the number: "); 
scanf("%d",&num); 
f=fact(num); 
printf("\n The factorial of the number %d is %d",num,f); 
getch(); 
} 
int fact(int n) 
{ 
if(n==0 || n==1) 
return 1; 
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else 
return(n * fact(n-1)); 
} 
OUTPUT = 
Enter a number 3 
The factorial of the number 3 is 6 
Q10. W.A.P in C to find the sum of Fibonacci series, by using 
function. 
#include <stdio.h> 
void Fibo(int r); 
void main() 
{ 
Int range; 
printf(“ enter the range of Fibonacci series :”); 
scanf(“%d”, &range); 
fibo(range); 
} 
void fibo(int r) 
{ 
Int a=0, b=1, c, sum=0; 
while( a <= r) 
{ 
sum +=a; 
c = a+b; 
a = b; 
b = c; 
} 
Printf(“sum of fibo series is %d”,sum); 
} 
OUTPUT = enter the range of Fibonacci series :4 
sum of fibo series is 7 
Q 11. W.A.P in C to accept a number from keyboard and print it in 
reverse order of entry, by using function. 
#include <stdio.h> 
void reverse(int no); 
void main() 
{ 
int n ; 
printf("Enter a number“); 
scanf("%d", &n); 
reverse (n); 
} 
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void reverse(int no) 
{ 
int rev = 0, rem,temp; 
temp = no; 
while (temp != 0) 
{ 
rem = temp % 10; 
rev = rev * 10 + rem; 
temp = temp/10; 
} 
printf("reverse of the no is %d \n", rev); 
} 
Output = 
Enter a number 131 
Reverse of the no is 131 
Q12. W.A.P in C to compute the sine series. 
// WAP to find the sine series 
#include<stdio.h> 
#include<math.h> //sine and M_PI is defined in math.h 
void main() 
{ 
float angle,value; 
printf("Enter an angle:"); 
scanf("%f",&angle); 
value=sin(angle*M_PI/180); //M_PI is a constant used to 
represent pi 
printf("sin(%.0f)=%.4f",angle,value); 
getch(); 
} 

Output:  Enter an angle: 30 
sin(30)=0.5 

 

COURSE OUTCOME OF COMPUTER APPLICATION LAB (PR-1) 
CO1 Analyze the working and application of PC and internet 
CO2 Apply the different tools and utilities of the Operating System (DOS, 

Windows) 
CO3 Use MS Office to create, edit Word file, Spreadsheet and present 

documents 
CO4 Develop programs by using ‘C’ language. 
CO5 Write and explain the procedure of the experiments conducted 
 


